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Introduction About this Guide viii
Introduction

Welcome Welcome to the IBM® Sterling Gentran:Server® for UNIX - Workstation electronic 
data interchange (EDI) and electronic commerce (EC) software. 

Who should use
this guide

This guide is for the following audiences:

◗ Administrators responsible for installing and configuring EDI or EC application 
software

◗ Users of the IBM® Sterling Gentran:Server® for UNIX - Workstation product

Use this table to determine which chapters are for you. 

Reference
See the Chapter Content topic for a description of each chapter. 

Note
This guide documents procedures for the Application Integration system. 

If you are... Then refer to...

An administrator Chapter 1-2

Using Sterling Gentran:Server 
for the first time

Chapters 3-5

A user and you are upgrading 
from Sterling Gentran:Server 
5.4

Chapters 3-5

A user and you are upgrading 
from Sterling Gentran:Server 
5.3 or prior version

Chapters 3-6
Getting Started Guide – May 2011



About this Guide Introduction  ix
Required skills This guide assumes that you are familiar with basic Windows concepts and 
commands, including:

◗ How to navigate and operate within the Windows environment
◗ How to use DOS commands and the DOS window within the Windows 

desktop

Product
packaging

Your IBM® Sterling Gentran:Server® for UNIX - Workstation package should 
include the following items:

◗ A CD containing the IBM® Sterling Gentran:Server® for UNIX - Workstation 
software and the Communications Toolkit

◗ A CD containing the Sterling Gentran:Server EDI Standards
◗ A CD containing the Sterling Gentran:Server online documentation
◗ The IBM® Sterling Gentran:Server® for UNIX - Workstation Getting Started 

Guide

WARNING
If additional installation instructions came with your Sterling 
Gentran:Server shipment, those instructions take precedence over 
the instructions listed here.
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Supported Configurations About this Guide x
Supported Configurations

Hardware
specifications

Each workstation computer needs the following resources for you to install and 
run IBM® Sterling Gentran:Server® for UNIX - Workstation version 6.2.

◗ A CD-ROM drive
◗ Microsoft Windows XP® SP2
◗ Windows 7
◗ A minimum of 1 GB of free disk space 

Note
Your Windows operating system may require updates to work correctly. Check the 
following Microsoft web site to determine and download the latest service packs 
for your operating system:

http://www.microsoft.com/windows/downloads/default.asp
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About this Guide Chapter Content  xi
Chapter Content

Description of
content

This table describes the content of the chapters within the IBM® Sterling 
Gentran:Server® for UNIX - Workstation Getting Started Guide.

Chapter Title Description

About this Guide This preface describes the purpose and content 
of this guide. It describes the supported 
hardware and software configurations.

Chapter 1 - Installing IBM® 
Sterling Gentran:Server® 
for UNIX - Workstation

Explains how to install IBM® Sterling 
Gentran:Server® for UNIX - Workstation 
version 6.2 into a new directory.

Chapter 2 - Setting Up 
Communications

Explains how to set up communications using 
CLEO software. 

Chapter 3 - Introducing 
Sterling Gentran:Server

Describes the basic architecture of the Sterling 
Gentran:Server software.

Chapter 4 - Using Sterling 
Gentran:Server

Explains how to start and exit Sterling 
Gentran:Server, describes the user interface, 
and explains how to set default values for your 
system.

Chapter 5 - Working with 
Application Integration

Contains procedures for working with 
Application Integration system files in 
Workstation. Includes instructions for checking 
out, saving, and checking in files.

Glossary Sterling Gentran:Server and industry-related 
terms.
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Product Installation

In this guide This guide explains how to install and configure:

◗ IBM® Sterling Gentran:Server® for UNIX - Workstation version 6.2
◗ Online documentation for Sterling Gentran:Server
◗ The Sterling Gentran:Server Standards
◗ The Communications Toolkit

Note
These instructions apply only to new installations of IBM® Sterling 
Gentran:Server® for UNIX - Workstation.

Installation
options

You can install each option separately after installing the core Sterling 
Gentran:Server software. This table lists the CD containing each option and the 
instructions for installing the option.

To install the… Use…

XML Translation 
Extension

the core installation CD.

Note
This option is installed during the core product installation. 
The serial number you enter validates your purchase of 
the XML Translation Extension.

HIPPA features the core installation CD.

Note
The installation process asks if you want to install optional 
HIPAA features for Sterling Gentran:Server.

Extensions the documentation shipped with other options or add-on 
software for installation instructions.
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About this Guide Related Publications  xiii
Related Publications

Sterling
Gentran:Server
documentation

This table describes additional documentation for the Sterling Gentran:Server 
software.

Document Description

IBM® Sterling 
Gentran:Server® for 
UNIX Upgrade and 
Data Conversion 
Guide

Instructions for upgrading from previous versions of 
IBM® Sterling Gentran:Server® for UNIX and IBM® 
Sterling Gentran:Server® for UNIX - Workstation. Also 
includes instructions for converting the files that are 
part of the upgrade.

IBM® Sterling 
Gentran:Server® for 
UNIX Installation 
Checklist

Description of the recommended sequence in which 
you should install and configure system components.

IBM® Sterling 
Gentran:Server® for 
UNIX Getting Started 
Guide

Instructions for installing the Sterling Gentran:Server 
software and performing setup tasks, such as setting 
up security.

Instructions for starting and exiting Sterling 
Gentran:Server and for setting preferences and default 
values. Also includes instructions for checking files in 
and out and saving files.

IBM® Sterling 
Gentran:Server® for 
UNIX Application 
Integration User 
Guide

Instructions for performing mapping and translation 
tasks using the Sterling Gentran:Server Application 
Integration system. 

IBM® Sterling 
Gentran:Server® for 
UNIX HIPAA 
Compliance and 
NCPDP User Guide

Instructions for mapping and translating NCPDP files 
with the Application Integration system.

IBM® Sterling 
Gentran:Server® for 
UNIX GENCOD User 
Guide

Instructions for mapping and translating GENCOD files 
with the Application Integration system.

IBM® Sterling 
Gentran:Server® for 
UNIX VDA User 
Guide

Instructions for mapping and translating VDA files with 
the Application Integration system.
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Related Publications About this Guide xiv
IBM® Sterling 
Gentran:Server® for 
UNIX Technical 
Reference Guide

Describes processes, lists command-line commands in 
alphabetical order, and describes file record layouts 
and data type formats.

IBM® Sterling 
Gentran:Server® for 
UNIX - EC 
Workbench Data Flow 
Administration Guide

User instructions for configuring data flows using the 
Sterling Gentran:Server software.

IBM® Sterling 
Gentran:Server® for 
UNIX - Process 
Control Manager Data 
Flow Administration 
Guide

User instructions for configuring data flows using the 
Sterling Gentran:Server software.

IBM® Sterling 
Gentran:Server® for 
UNIX Maintenance 
and Troubleshooting 
Guide

Instructions for maintaining your Sterling 
Gentran:Server installation. Also provides 
troubleshooting information to help determine the 
cause and solution of problems that may occur.

IBM® Sterling 
Gentran:Server® for 
UNIX - Workstation 
Maintenance and 
Troubleshooting 
Guide

Instructions for maintaining your workstation 
installation. Also provides troubleshooting information 
to help determine the cause and solution of problems 
that may occur.

IBM® Sterling 
Gentran:Server® for 
UNIX with ADD User 
Guide

Instructions for configuring and using the Advanced 
Data Distribution system.

IBM® Sterling 
Gentran:Server® for 
UNIX XML 
Translation User 
Guide

Instructions for mapping and translating XML files with 
the Application Integration system.

Document Description
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About this Guide Related Publications  xv
IBM® Sterling 
Gentran:Server® for 
UNIX with ADD FTP 
Daemon User Guide

Instructions for configuring and using the FTP Daemon 
tool with IBM® Sterling Gentran:Server® for UNIX with 
ADD.

Online Help Context-sensitive help screens describing the Sterling 
Gentran:Server dialog boxes and features. Also 
includes procedures for using the mapping and 
translation and the data flow administration software.

Document Description
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Overview 0

Introduction

Chapter contents This chapter contains instructions for installing IBM® Sterling Gentran:Server® for 
UNIX - Workstation version 6.2 into a new directory structure.

Key terms This table describes key terms used in this chapter.

Term Description

default A value that is automatically assigned if the user enters 
no value.

Windows computer A PC that uses the Windows operating system. For 
IBM® Sterling Gentran:Server® for UNIX - Workstation, 
the operating system can be:

◗ Microsoft Windows XP® SP2
◗ Microsoft Windows 7
Getting Started Guide – May 2011
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Stages of Installation

Stage Table This table describes the stages of the installation process for IBM® Sterling 
Gentran:Server® for UNIX - Workstation. Detailed instructions for completing 
each stage are contained in the sections that follow.

XML installation The XML translation option is installed on your computer automatically if your 
company purchased the option.

Stage Description

1 Installation of Sterling Gentran:Server into the default 
directories, or into a new directory created and named by 
you, and installation of the Communications Toolkit

2 Installation of Microsoft Data Access Components

3 Installation of Sterling Gentran:Server EDI Standards

4 Installation of the Sterling Gentran:Server online 
documentation

5 Installation of Acrobat Reader version 4.0 or higher with 
search function

6 Conversion of existing data, if upgrading from a previous 
version

Reference
See the IBM® Sterling Gentran:Server® for UNIX 
Upgrade and Data Conversion Guide for more 
information.
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Procedures 0

How to Install Sterling Gentran:Server for UNIX - 
Workstation

Introduction This topic explains how to install IBM® Sterling Gentran:Server® for UNIX - 
Workstation software onto a Windows computer from the CD.

Procedure Use the following procedure to install Sterling Gentran:Server.

Step Action

1 Close all programs running on your computer.

2 Insert the installation CD into the CD-ROM drive of your PC. 

The Welcome dialog box is displayed.

Click Next to continue.

Comment

If the Welcome dialog box is not displayed, then you can do the 
following to start the installation.

Select Run from the Start menu in the Run dialog box, type the 
following command where <drive> represents the letter 
assigned to your CD-ROM drive, then click OK.

Example
<drive>:\setup

3 Enter the following information and click Next:
◗ User Name
◗ Company Name
◗ Install XML
Getting Started Guide – May 2011
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4 Select the Destination Folder for the installation. You can 
browse to a destination folder or choose to keep the default 
destination folder displayed. 

Select Next to continue.

Comments
You can type into the Browse dialog a path that Setup will 
create during installation. If the pathname contains a 
folder that does not exist, Sterling Gentran:Server 
displays the prompt: Do you want to the folder to be 
created?”

Be sure that the path you specify contains no spaces, 
and no punctuation other than a backslash (\) between 
directories.

WARNING
If you have an earlier version of Sterling 
Gentran:Server installed, be sure to use a different 
root directory for your Sterling Gentran:Server 6.2 
software.

5 Select Program Folder.

Default is Server Gentran Server Workstation 6.2.

Click Next to continue.

6 Review the setup information.

Click Install to begin the installation.

7 Do you want to install the Microsoft Data Access Components 
(MDAC)?

◗ If YES, GO TO topic How to Install MDAC 2.8 Components 
in this chapter.

◗ If NO (you already have MDAC), clear the checkbox and 
continue to the next step.

Note
You must have MDAC to use the Sterling Gentran:Server EDI 
Standards database. The minimum version required is 2.1sp1a. 
This MDAC installation process installs version 2.8.

 (Contd)
Step Action
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4 Select the Destination Folder for the installation. You can 
browse to a destination folder or choose to keep the default 
destination folder displayed. 

Select Next to continue.

Comments
You can type into the Browse dialog a path that Setup will 
create during installation. If the pathname contains a 
folder that does not exist, Sterling Gentran:Server 
displays the prompt: Do you want to the folder to be 
created?”

Be sure that the path you specify contains no spaces, 
and no punctuation other than a backslash (\) between 
directories.

WARNING
If you have an earlier version of Sterling 
Gentran:Server installed, be sure to use a different 
root directory for your Sterling Gentran:Server 6.2 
software.

5 Select Program Folder.

Default is Server Gentran Server Workstation 6.2.

Click Next to continue.

6 Review the setup information.

Click Install to begin the installation.

7 Do you want to install the Microsoft Data Access Components 
(MDAC)?

◗ If YES, GO TO topic How to Install MDAC 2.8 Components 
in this chapter.

◗ If NO (you already have MDAC), clear the checkbox and 
continue to the next step.

Note
You must have MDAC to use the Sterling Gentran:Server EDI 
Standards database. The minimum version required is 2.1sp1a. 
This MDAC installation process installs version 2.8.

 (Contd)
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8 Click Finish to complete setup.

Comment

You will need to decide if you want to restart your 
computer now or later.

System Response
Setup displays the Sterling Gentran:Server 6.2 dialog 
box

 (Contd)
Step Action
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How to Install MDAC 2.8 Components

Introduction To read the EDI standards provided with Sterling Gentran:Server, you must have 
Microsoft Data Access Components (MDAC) 2.1sp1a or higher installed on each 
PC or client. MDAC includes ActiveX® Data Objects (ADO), and OLE DB. Data-
driven client/server applications use these components to integrate information 
from a variety of sources. 

If you do not already have MDAC on the PC, you must install it before you install 
the EDI standards. This topic explains how to install MDAC.

Installing MDAC Use this procedure to install MDAC 2.8 on a PC. 

Step Action

1 Use this table to determine your first action.

IF you are … THEN…

Continuing from the PC 
setup program

Leave the I would like to install 
Microsoft MDAC 2.8 check box 
selected on the Setup Complete 
dialog box. Click Finish and GO 
TO Step 5.

Installing MDAC after 
exiting the PC setup 
program

Continue with Step 2.

2 Insert the installation CD into the CD-ROM drive of the PC 
computer. 

3 Select Run from the Windows Start menu.

System Response
Windows displays the Run dialog box.
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4 Type the following command in the Run dialog box and click 
OK.

<drive>:\mdac_typ.exe

where <drive> is your CD-ROM drive.

System Response
The system response is dependent on your operating 
system. 

5 Click Next.

6 Click Finish.

7 Click Close.

System Response
Setup displays the Sterling Gentran:Server Setup 
complete dialog box, which asks whether you want to 
reboot the PC now or later.

8 Click Finish to complete setup.

 (Contd)
Step Action
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Sterling Gentran:Server Standards

Installing the
Standards
Database

Use the Sterling Gentran:Server EDI Standards documentation to install the 
Sterling Gentran:Server EDI Standards.
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How to Convert Existing Data

Introduction If you are upgrading from an earlier version of Sterling Gentran:Server, you need 
to convert your existing data. 

Reference Refer to the IBM® Sterling Gentran:Server® for UNIX Upgrade and Data 
Conversion Guide for detailed instructions.
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Overview 0

Introduction

The
Communications

Toolkit

The Communications Toolkit enables Sterling Gentran:Server to use Cleo A+® or 
Cleo 3780Plus® communication software to access a Value-Added Network 
(VAN). 

Among other services, VANs provide store-and-forward messaging in a dial-on-
demand environment. This means that the VAN stores files in a mailbox until the 
recipient to whom they are addressed dials into the VAN and picks them up. 

When to use the
Communications

Toolkit

Use the Communications Toolkit if you connect to the Commerce Net®, 
Advantis®, or GEIS® networks, and you use or plan to use either Cleo A+ or Cleo 
3780Plus.

What do I need
to buy?

The Communications Toolkit is included with IBM® Sterling Gentran:Server® for 
UNIX - Workstation and IBM® Sterling Gentran:Server® for UNIX. 

However, Cleo A+ and Cleo 3780Plus are not part of the Sterling Gentran:Server 
product; you must purchase Interface Systems’ Cleo A+ or Cleo 3780Plus 
communication software. 

How to activate
the

Communications
Toolkit

To activate the toolkit functions, you need to configure the Communications Toolkit 
and then install the Cleo software.

Communications Toolkits files are included in the Sterling Gentran:Server host CD 
and are installed automatically with the Sterling Gentran:Server host software.

In this chapter This chapter provides instructions for setting up the toolkit.
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What Is the Communications Toolkit?

Command
scripts

IBM provides command scripts for the third-party communication packages, Cleo 
3780Plus and Cleo A+. The scripts control the processes of:

◗ Dialing the VAN
◗ Logging in
◗ Transmitting waiting files
◗ Receiving any files waiting on the VAN
◗ Logging off 
◗ Exiting

Supported VANs This table describes the VANs and protocols supported by the Communications 
Toolkit.

Toolkit parts There are two primary parts to the Communications Toolkit provided with Sterling 
Gentran:Server:

◗ Cleo A+ scripts and configuration files
◗ Cleo 3780Plus scripts and configuration files

Cleo software Cleo A+

Interface Systems’ Cleo A+ is an asynchronous communications package that 
uses sophisticated scripting to handle various types of communications. It 
supports several file transfer methods, including ASCII, Xmodem, Ymodem, 

VAN Supported Protocols

IBM® Sterling Information Broker®

(IBM)

Asynchronous-ASCII

Bisynchronous

Advantis 

(IBM)

Asynchronous-Xmodem

Bisynchronous

GEIS 

(General Electric Information System)

Asynchronous-Xmodem

Bisynchronous
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Zmodem, Kermit, and ANSI CLEAR. It can also perform as an FTP tool, using 
SLIP, PPP, Telnet, or local modes.

Cleo 3780Plus

Interface Systems’ Cleo 3780Plus is a bisynchronous communications package 
that uses scripting to handle various types of communications. It supports 2780/
3780 bisync protocols by using a piece of hardware to convert ASCII data to 
EBCDIC data for transmission and EBCIDIC data to ASCII data upon receipt of 
the EBCDIC data.

WARNING
The scripts in the Communications Toolkit expect to find the Cleo 
software in a specific directory relative to the Sterling Gentran:Server 
directories. To prevent complications, install the Cleo software after 
you install and set up Sterling Gentran:Server and the 
Communications Toolkit.
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COMM Subdirectory Structure

Diagram The following diagram illustrates the directory structure required by the 
Communications Toolkit. Installation of Sterling Gentran:Server automatically 
installs the Communications Toolkit files for you.

Location of
communication

scripts and
configuration

files

The Cleo communications script and configuration files reside in subdirectories of 
the COMM CleoA or CleoB subdirectory of the Server directory.  

Directory Contents

Server/COMM/CleoA 

                 (A+)

Holds Cleo A+ asynchronous package

Server/COMM/CleoB

            (3780Plus)

Holds Cleo 3780Plus bisynchronous package
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VAN
subdirectories

Under the CleoA and CleoB subdirectories, each VAN has its own subdirectory:

◗ cnet for Sterling Information Broker
◗ adv for Advantis
◗ geis for GEIS.

Subdirectory
contents

The adv, cnet, and geis subdirectories contain files that enable the 
communications application to communicate with the corresponding VAN.

You should use the subdirectory appropriate to your network to hold the outbound 
file <van>s that you are transmitting to the VAN. 

Note
You should place files you are sending in the communications subdirectory before 
a session. For example, to send a file to Advantis via an asynchronous 
communication session, place the file in Server/COMM/CleoA/adv/advs.

During a session, the system places the inbound file <van>r.000 in the 
communication subdirectory. This file contains any files received during a 
communications session. 

Important files This table lists the important files that the Communications Toolkit uses or creates. 

Filename Description

<van>.cfg A configuration file specific to the VAN indicated in the 
file name.

edilog.fil A log file produced by each bisynchronous Advantis 
session.

WARNING
The program overwrites this file after each 
session. To save this file, you must copy or 
move it to another location.

advmsg.fil A file containing messages produced by each 
bisynchronous Advantis session.

WARNING
The program overwrites this file after each 
session. To save this file, you must copy or 
move it to another location.
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<van>*.job Cleo job file for connecting to the supported networks. 
The individual files connect as follows:

◗ cnetsr.job - Sterling Information Broker via the 
CompuServe network local access nodes.

◗ advsr.job - IBM Advantis network
◗ geissr.job - GEIS network

<van>.log A log file specific to the last connection made to the 
indicated VAN.

<van>.mon A monitor file specific to the last connection made to 
the indicated VAN.

<van>.ovr A data translation file that provide protocol transfer 
information that Cleo requires.

cnet.rpts A file containing Sterling Information Broker reports. 

<van>s The user data file to be sent to the network. Must be 
placed in the directory for the specific VAN before 
connecting to the VAN. 

WARNING
You must move or delete this file after 
completing the session successfully. 

Sterling Gentran:Server will send a duplicate 
transmission unless this file is overwritten or 
deleted before the next session.

Sterling Gentran:Server may overwrite the file 
if you do not move it before the next session. 
The file will then be unavailable to retransmit 
data.

 (Contd)
Filename Description
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<van>r.nnn The user data file that Sterling Gentran:Server receives 
from the VAN. The first file received has an extension 
of .000. If the file is moved from the VAN directory 
before another file arrives, the next file received also 
has an extension of .000.

WARNING
The file extension is incremented by one with 
the receipt of each new file unless the prior 
version is moved or deleted before the 
session. If your site uses automated file 
processing, it may not recognize the 
incremented file. 

geisrpt.* A session log report generated by GEIS under 
3780Plus or AllSync.

WARNING
The program overwrites this file after each 
session. To save this file, you must copy or 
move it to another location.

 (Contd)
Filename Description
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The Communications Toolkit Setup Process

Process flow This diagram shows the flow of the setup process required to prepare the 
Communications Toolkit to work with Sterling Gentran:Server.

Set Up 
Communications

Toolkit

Install Cleo 
Communications

Software

Install
Sterling Gentran:Server
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Procedures 0

How to Set Up Asynchronous Communications

Introduction This topic contains the procedures for setting up asynchronous communications 
using VAN scripts that are located in the COMM directory structure. Follow the 
instructions for the VAN to which you are connecting.

Microcom
Network

Protocol (MNP)

The Microcom Network Protocol (MNP) enables error correction during 
transmissions. It is particularly important when connecting to Sterling Information 
Broker. 

Modifying the
VAN

configuration file

Your Cleo A+ VAN configuration file (cnet.cfg, adv.cfg, or geis.cfg) contains all or 
most of the required network configurations. However, you may have hardware 
issues that require you to modify the file.

This table lists the environment parameters you may need to modify. The 
Parameter column lists the name of the parameter and the related file.

Parameter Description

Modem 
Initialization 

(modeminit.cfg)

This parameter normally contains the async factory 
default setting for your modem. To use another setting, 
check the AT commands in your modem user guide. 
Usually, the setting & F0 sets up most asynchronous 
modems in standard asynchronous mode. 

Port

(device.cfg)

This is the port to which the modem is installed. 

◗ If you use DOS or Windows, you may use COM2 or 
a similar setting.

◗ If you use UNIX, you may use /dev/ttyp3 or a similar 
setting.

Port Speed

(speed.cfg)

This parameter identifies to Cleo the baud rate of the port 
so that Cleo knows how fast to write to the port. This is 
NOT the dial-up connection speed or the modem baud 
rate.
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Terminal Type

(terminal.cfg)

The terminal type is usually VT100 or VT220, depending 
on the terminal type to be emulated. Refer to the Cleo 
documentation for more information.

Dial Initialization This is the most important configuration parameter. It is 
used to set the unique configuration that a particular VAN 
expects. Use the following table to guide you in setting 
this parameter.

VAN Dial-Initialization Settings

Sterling
Information
Broker

◗ MNP error correction protocol
◗ Software Flow Control (also known 

as XON/XOFF Flow Control)

Advantis ◗ MNP error correction protocol
◗ Hardware Flow Control (RTS/CTS)
◗ FTP: Xmodem (in addition to the 

MNP protocol)

GEIS ◗ Either Hardware Flow Control 
(RTS/CTS) or Software Flow 
Control

CAUTION
If you use Software Flow Control, 
make sure the Dial Init and 
FLOWCONTROL setting in the 
configuration file are compatible.
◗ FTP: Xmodem

 (Contd)
Parameter Description
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How to Set Up Bisynchronous Communications

Introduction This topic contains the procedure for setting up bisynchronous communications 
using VAN scripts that are located in the COMM directory structure. Follow the 
instructions for the VAN to which you are connecting.

Editing the
configuration file

Your Cleo 3780Plus VAN configuration file (cnet.cfg, adv.cfg, or geis.cfg) contains 
all or most of the required network configurations. However, you may have 
hardware issues that require you to modify the file.

The parameter settings that sometimes need to be increased are:

◗ Wait Limit
◗ Retransmission Limit

Important
The configuration file does not contain any labels. Consult the Cleo 
documentation to determine which lines to edit within the file.

Use this procedure to edit the configuration file for Sterling Information Broker, 
Advantis, and GEIS.

Step Action

1 Open the VAN Configuration File in a text editor.

2 Set the Wait Limit as needed.

3 Set the Retransmission limit as needed.

4 Initiate a Cleo session so you can test communications to the 
VAN. 

5 Check whether a completion status of ‘0’ was returned.

◗ If the status was 0, you are finished editing the 
configuration file.

◗ If a non-zero was returned, use the <van>.log and 
<van>.mon files to troubleshoot.

Reference
See the topic Cleo 3780Plus Troubleshooting for more 
information.
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Editing the job
file

Use this procedure to edit the job file for cnet bisync communications.

Step Action

1 Open the job file in a text editor.

2 Set the dialing command.

Example
AUTODIAL n-nnn-nnn-nnnn T60 R3

Where 

n-nnn-nnn-nnnn is the connection telephone number

T60 is the time in seconds to wait for a connection to complete

R3 is the number of times to retry a connection attempt.

Comment
We recommend that you use the default time and retry 
settings.

3 Set mailbox ID and password. You must set it in three separate 
places:

KEY $$REQ ID=xxxxxR BID=’nnnnnnn’ -x

KEY $$REQ ID=xxxxxD BID=’nnnnnnn’ -x

KEY $$ADD ID=xxxxxD BID=’nnnnnnn’ -x

Where 

xxxxx is the five character network mailbox ID

nnnnnnn is the seven digit password.

Warning
These are the only changes to the job file approved 
by IBM. Any other changes will NOT be supported by 
IBM Customer Support.
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How to Start Up Cleo A+

Description Interface Systems’ Cleo A+ is an asynchronous communications package that 
uses sophisticated scripting to handle various types of communications. It 
supports several file transfer methods, including raw ASCII, Xmodem, Ymodem, 
Zmodem, Kermit, and ANSI CLEAR. It can also perform as an FTP tool, using 
SLIP, PPP, Telnet, or local modes.

Cleo A+ start-up
command

The Cleo A+ start-up command consists of the command to execute the 
application A+ and several parameters. The two most important parameters are 
the job file and tokens, which are explained below.

The rest of the information that you can place in the start-up command is identified 
within the job file. A log file is generated automatically. 

.job file This parameter identifies the job file to use for the session. The job file determines 
how Cleo manages a communication session. There is a separate job file for each 
VAN which ends with the extension .job. For example, the Advantis job file is 
advsr.job. 

This table lists the job file that corresponds to each supported VAN.

VAN Async (COMM/CleoA/.) Job File

Sterling Information Broker via CompuServe .cnetsr.job

Advantis Expedite/Async .advsr.job

GEIS EDI*Express .geissr.job
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Tokens A token is a piece of information that is passed to a job, such as the VAN 
telephone number or your VAN ID. The token parameter identifies the tokens to 
be passed to the job as it is running. 

This table lists the available A+ tokens for each VAN.

VAN
Token 

Number Description

Advantis 1 Telephone/modem access number. 
(n-nnn-nnn-nnnn)

2 IBM Network Account ID.

3 IBM Network User ID.

4 IBM Network Password.

5 Information Exchange Network Account ID.

6 Information Exchange Network User ID.

7 Information Exchange Network Password.

Sterling 
Information 
Broker

1 Telephone/modem access number. 
(n-nnn-nnn-nnnn)

2 Mailbox ID. (Sxxxx)

3 Mailbox password. (nnnnnnn)

4 Mailbox Application ID obtained from network 
support. (EDIx)

5 Report slot ID. (xxx)

6 Data slot ID. (xxx)

7 Node access host. (compu)

GEIS 1 Telephone/modem access number. 
(n-nnn-nnn-nnnn)

2 GEIS Network User Number.

3 GEIS Network User Password.

4 Last three digits of the GEIS User Number.
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Example start-up
command

A+ jobfile=./cnet/cnetsr.job “tokens=18005551212 SX999 1234567 EDIx R D mci”
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How to Start Up Cleo 3780Plus 

Description Interface Systems’ Cleo 3780Plus is a bisynchronous communications package 
that uses scripting to handle various types of communications. It supports 2780/
3780 bisync protocols by using a piece of hardware to convert ASCII data to 
EBCDIC data for transmission and EBCDIC data to ASCII data upon reception of 
the EBCDIC data.

Cleo 3780Plus
start-up

command

The Cleo 3780Plus start-up command consists of the Cleo command 3780Plus’ 
along with several other parameters. These are required parameters:

You can use the following optional parameters in the start-up command.

Note
The log is not required. However, IBM Customer Support personnel must have the 
log to assist you in troubleshooting any communication difficulties you may 
encounter. 

Parameter Description

-d Identifies the device or communications port to use this 
session.

-j Identifies the .job file to run.

VAN Bisync (COMM/CleoB/..) Job File

Sterling Information Broker .cnetsr.job

Advantis Expedite/Direct .advsr.job

GEIS EDI*Express .geissr.job

-k Used to pass the tokens to the .job file as it is running.

Parameter Description

-c Identifies the configuration file to use. The .job file includes this 
information. 

-LO Directs Cleo to generate a new log for the session if one does 
not exist in the COMM directory or overwrite an existing one. 
This command is recommended. 
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GEIS and
Advantis tokens

This table lists the available 3780Plus or AllSync tokens for GEIS and Advantis.

Note
To control startup of bisynchronous communications for Sterling Information 
Broker, you need to edit the job file instead of using tokens.

Reference
See the How to Set Up Bisynchronous Communications topic in this chapter.

Example start-up
command

3780Plus -d /dev/tty03 -j ./geis/geissr.job -k 18005551212 GEISID GEISPSWDnnn -LO

VAN
Token 

Number Description

Advantis 1 Connection telephone number. 

2 IBM Network Account ID.

3 IBM Network User ID.

4 IBM Network Password.

5 Information Exchange Network Account ID. 

6 Information Exchange Network User ID.

7 Information Exchange Network Password.

GEIS 1 Connection telephone number.

2 GEIS Network User Number.

3 GEIS Network User Password.

4 Last three digits of the GEIS User Number.
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Start-Up Procedure Examples

Introduction Communications is not a Sterling Gentran:Server application and the procedures 
to start communications can vary from environment to environment. Once 
communications are set up, you use the same commands to start it regardless of 
the platform.

Initiating
communications

through
automated

procedures

The communications toolkit has certain expectations regarding file placement. 
You can automate processes to move the file to and from the VAN directories. You 
can also automate the start-up process using .bat files created in DOS or 
Windows, or shell scripts created in UNIX or open systems. 

Examples The following examples show what you can implement into an automated 
communications procedure.

DOS or Windows Users
.BAT File Example

copy C:\Server\ediout?.fil C:\Server\comm\cleoa\cnet\cnets

del C:\Server\ediout?.fil

cd \Server\comm\cleoa

aplus jobfile=.\cnet\cnetsr.job “tokens=5551212 SX999 1234567 EDIx R D mci”

copy C:Server\comm\cleoa\cnet\cnetr C:\Server\comm\cleoa\ediin?.fil

del C:\Server\comm\cleoa\cnet\cnetr

UNIX Systems Users
Shell Example

cp/Server/ediout?.fil /Server/comm/cleoa/cnet/cnets

rm/Server/ediout?.fil

cd/Server/comm/cleoa

A+ jobfile=./cnet/cnetsr.job “tokens=5551212 SX999 1234567 EDIx R D mci”

***error recovery procedures ie; if$? =gt 0 ...****
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cp /Server/comm/cleoa/cnet/cnetr /Server/edliin?.fil

rm /Server/comm/cleoa/cnet/cnetr

Example start-up
command

3780Plus -d /dev/tty03 -j ./geis/geissr.job -k 18005551212 GEISID GEISPSWD -LO
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Troubleshooting 0

Communications Session Error Recovery

Introduction With communications applications, failures can occur. The communications 
scripts developed by IBM are designed to handle common communications 
errors. 

Error messages
and end codes

The communications script files (<van>sr.job files), have an “error Fall Thru” 
section. This section lists the messages that the Cleo application writes to the .log 
file. Each time a session error occurs, the .job file posts a relevant error message 
to the log and returns an end code when it exits the Cleo application. You can use 
this end code in a shell script (UNIX) or .bat file (DOS/Windows) to decide 
whether communications ended successfully. An end code of 0 indicates success 
and a non-zero value indicates a failure. The various end code values indicate 
why the failure occurred. 

Sterling
Information

Broker Async
end codes

This table describes the possible end codes generated by a Cleo application in 
Async (A+) mode and the meaning of each.

Sterling Information Broker Async (A+)

End Code Meaning

0 Session successful; continue processing.

Non-zero values: Require further examination

35 Error occurred during dial attempts; connection never 
established.

50 Error occurred at some point during the logon process to 
the network. Connection established to communication 
node but no session established with host. 

60 Error occurred while attempting to transmit your 
outbound data to the network; resend data.

70 Error occurred while attempting to receive inbound data 
or reports from the network; any data to be sent during 
that session was NOT sent; retry may be required.
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Sterling
Information

Broker Bisync
end codes

This table describes the possible end codes generated by a Cleo application in 
Bisync (3780Plus) mode and the meaning of each.

Advantis
Expedite/Direct

Async end codes

This table describes the possible end codes generated by a Cleo application in 
Async (A+) mode and the meaning of each.

Sterling Information Broker Bisync (3780Plus)

End Code Meaning

0 Session successful; continue processing.

Non-zero values: Requires further examination

35 Error occurred during dial attempts; connection never 
established.

40 Error occurred during receive process for inbound data 
or reports from the network; retry may be required.

50 Error may have occurred at some point during transmittal 
of ‘request cards’, ‘add’ card’, or outbound data file; retry 
may be required.

Advantis Expedite/Direct Async (A+)

End Code Meaning

0 Session successful; continue processing.

Non-zero values: Requires further examination

35 Error occurred during dial attempts; connection never 
established.

40 Error occurred during logon process; session never 
established communication to Advantis network, even 
though connection was made. 

50 Error occurred during transmittal of outbound data to 
Advantis network.

55 Error occurred during transmittal of outbound flat file data 
to Advantis network.
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Advantis
Expedite/Direct

Bisync end
codes

This table describes the possible end codes generated by a Cleo application in 
Bisync (3780Plus) mode and the meaning of each.

60 Error occurred during reception of inbound data from 
Advantis network; retry may be needed.

65 Although data may have been collected by 
communications, Advantis may not recognize this 
because the session failed after the data was received; 
they may send duplicate data in following session. 

70 Logoff process failed and Advantis may not have 
collected or acknowledged your receipt of data.

 (Contd)
Advantis Expedite/Direct Async (A+)

End Code Meaning

Advantis Expedite/Direct Bisync (3780Plus)

End Code Meaning

0 Session successful; continue processing.

Non-zero values: Requires further examination

35 Error occurred during dial attempts; connection never 
established. 

40 Error occurred during logon process; session never 
established communication to Advantis network even 
though connection was made.

50 Error occurred during transmittal of data.

55 Error occurred during transmittal of ‘receive’ and ‘receive 
log’ commands occurred, or acknowledgment from 
Advantis never received. 

60 Error occurred during receive process for inbound data 
file or reports from Advantis.
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GEIS
EDI*Express

Async end codes

This table describes the possible end codes generated by a Cleo application in 
Async (A+) mode and the meaning of each.

GEIS EDI*Express Async (A+)

End Code Meaning

0 Session successful; continue processing.

Non-zero values: Require further examination

35 Error occurred during dial attempts; connection never 
established. 

40 Error occurred during logon process; session never 
established communication to GEIS network, even 
though connection was made. 

50 Error occurred during transmittal of commands 
associated with sending outbound data to Advantis 
network; data never sent. 

55 Error occurred during transmittal of outbound data to 
GEIS network.

60 Error occurred during transmittal of receive commands 
for inbound data from GEIS network.

65 Error occurred during reception of data from GEIS 
network.

70 Error occurred during logoff.
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GEIS
EDI*Express

Bisync end
codes

This table describes the possible end codes generated by a Cleo application in 
Bisync (3780Plus) mode and the meaning of each.

GEIS EDI*Express Bisync (3780Plus)

End Code Meaning

0 Session successful; continue processing.

Non-zero values: Requires further examination

35 Error occurred during dial attempts; connection never 
established. 

40 Error occurred during logon process; session never 
established communication to GEIS network even 
though connection was made.

50 Error occurred during transmittal of commands 
associated with sending outbound data to Advantis 
network; data was never sent. 

55 Error occurred during transmittal of outbound data to 
GEIS network.

60 Error occurred during transmittal of receive commands 
for inbound data from GEIS network, or failure occurred 
receiving data from GEIS network. 

65 Error occurred during transmission of  *EOS command; 
session may not even be recorded on GEIS network 
side.
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Cleo 3780Plus Troubleshooting

Introduction This section offers possible solutions to three of the most common situations. See 
your Cleo documentation for further information.

Problem and
solution table

This table lists common problems and solutions.

Problem Possible Solution

During a RECEIVE process, 
you encounter a WAIT error.

Increase the Wait Limit parameter in the Cleo 
configuration file (cnet.cfg, adv.cfg, or geis.cfg).

During a SEND process, you 
encounter a RETRAN error.

Increase the Retransmission Limit parameter in 
the Cleo configuration file (cnet.cfg, adv.cfg, or 
geis.cfg).

At any point in the session, 
you encounter a BIDLMT 
error.

Check the documentation for your modem and 
verify that it can handle synchronous 
communications, then try again. 

If the problem continues, contact IBM Customer 
Support for information and assistance.

Note
The BIDLMT error can occur when you attempt 
to connect to a bisynchronous line at a speed 
other than that of the line. For example, if you 
attempt to connect to a 9600 bisynchronous line 
at 2400 baud. 
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Connecting to Other VANs and Directly to Trading 
Partners

Introduction If you need to connect to a trading partner directly or to a VAN that is not 
supported by the Communications Toolkit, you will need to create a Cleo 
communications script to connect to the VAN. You may also need to create a 
configuration file.

About creating
communications

scripts

Scripts are usually created as ASCII text files, which you do not need to compile.

Cleo 3780Plus The Cleo 3780Plus communications application software enables an ASCII 
system to emulate a 2780 or 3780 terminal. With 3780Plus, you can transmit and 
receive data from any system that supports the 2780 or 3780 bisynchronous 
protocols.

The scripting facility in Cleo 3780Plus is relatively simple to use. However, you 
must understand the session protocol that the remote system requires.
Getting Started Guide – May 2011



Connecting to Other VANs and Directly to Trading Partners Setting Up Communications2 - 28
Basic Cleo
3780Plus

commands

The table below lists some basic Cleo commands and descriptions. See your Cleo 
3780Plus documentation for more detailed information.

Command Description

AUTODIAL tel# Txx Rxx Used to dial remote system modems for a 
communications connection.

◗ tel# = The number to connect to.
◗ Txx = The timer delay for waiting for an answer 

from the remote modem.
◗ Rxx = The retry parameter for number of 

attempts to retry if the dial attempt fails.

KEY msg -ENRX Used to send a user a specified message. Often 
used to send commands such as a system logon to a 
remote system. Unless otherwise specified, Cleo 
automatically transmits an End of Transmission 
(EOT) character when the message transmission is 
complete.

The switches that follow the command are used for 
protocol and translation functions. 

◗ -E = Suppress an EOT character after the 
message is transmitted.

◗ -X = Suppress an End of Text (ETX) character as 
well as an EOT character after the message is 
sent.

◗ -N = Send non-transparent data from the 
message through “as is” (no translation).

◗ -R = Suppress inter-record separators from the 
transmitted message.

TEXT path/filename -
ENRX

Used to transmit specified files to the remote system. 
The switches that follow the command (-ENRX) are 
used for protocol and translation functions. See 
descriptions above.
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Suggestions ◗ Reference the 3780Plus documentation to learn about the many other 
session script commands, startup options, and other functions not discussed 
in this appendix.

◗ Make sure you are familiar with all the options on the commands before you 
use them.

◗ Use the 3780.LOG file to review sessions for errors that may have occurred 
during the previous communications sessions.

◗ There is a Monitor file you can use as a line scope to determine what is being 
transferred to and from your system. This monitor is in EBCDIC Hexadecimal 
code. There is a conversion chart in the 3780Plus documentation that may 
help you read this trace.

Cleo A+ Cleo A+ enables users to transmit and receive files from systems that support 
asynchronous file transfer protocols. You can run sessions interactively or use 
scripts you have written to perform unattended functions. Several configuration 
options are available for file transfer: ASCII, Xmodem, Ymodem, Zmodem, 
Kermit, ANSI, and FTP (slip, ppp, telnet).

The scripting facility in Cleo 3780Plus is relatively simple to use. However, you 
must understand the session protocol that the remote system requires. A+ allows 
use of environment variables, user-defined variables, and the ability to control file 
naming during a session.

RECEIVE path/filename -
NX

Used to receive files from the remote system to a 
specified path and filename. A received EOT 
character terminates the command. A received ETX 
character causes Cleo to terminate the write to the 
specified file and start writing into an incremented 
filename. Depending on the user filename, Cleo may 
overwrite the previous data in the specified file.

Switches:

◗ -X = Ignore incoming ETX characters
◗ -N = Allow transparent data to be received “as is” 

(no translation)

VOICE Hangs up the phone and terminates a session. 
Usually, the command to terminate the Cleo 
3780Plus application (QUIT) follows this command.

 (Contd)
Command Description
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Basic Cleo A+
commands

This table includes descriptions of basic Cleo A+ commands used to start a 
dialup, send commands to a remote system, receive files, send files, and 
terminate the connection. See your CleoA+ documentation for more detailed 
information.

Command Description

AUTODIAL tel# Txx Rxx Used to dial remote system modems for a 
communications connection.

◗ tel# = The number to connect to
◗ Txx = The timer delay for waiting for an answer 

from the remote modem
◗ Rxx = The retry parameter for number of 

attempts to retry if the dial attempt fails

KEY msg -NTR Used to send a user a specified message. Often 
used to send commands such as a system logon to 
a remote system. Unless otherwise specified, Cleo 
automatically transmits a CR character when the 
message transmission is complete.

The switches that follow the command are used for 
protocol and translation functions. 

◗ -N= Send non-transparent data from the 
message through “as is” (no translation).

◗ -T= Force message through the translation 
table.

◗ -R= Suppress carriage return (CR) from the 
end of the transmitted message.

SEND path/filename / 
remote filename -TN

Used to transmit specified files to the remote 
system. The remote filename parameter is used to 
send the same filename to the remote system. The 
switches that follow the command (-TN) are used 
for translation functions.

◗ -T= Force message through the translation 
table.

◗ -N= Send non-transparent data from the 
message through “as is” (no translation).
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Suggestions ◗ Reference the A+ documentation to learn about the many other session script 
commands, startup options, and other functions not discussed in this 
appendix.

◗ Make sure you are familiar with all the options on the commands before you 
use them.

◗ Use the A+.LOG file to review sessions for errors that may have occurred 
during the previous communications sessions.

Configuration
file

Depending on your trading partner requirements, you may need to create a 
configuration file. The important thing to remember is that the settings defined in 
the configuration file that pertain to your system or your modem should always be 
in sync with each other. Be sure to talk to staff at the remote site to determine its 
requirements for connection. Never assume anything will work. Even if you guess 
on how to establish the connection you will still need to determine the session 
protocol. Talk to your remote staff!

Extended
Communications

Support
Services (ECS)

If you do not have the resources required to develop the communications or 
configuration file, IBM offers consulting services to create, maintain, install, and 
test communications. Contact IBM Customer Support and ask for 
communications support for information.

RECEIVE path/filename -
NT

Used to receive files from the remote system to a 
specified path and filename. Depending on the file 
transfer type you are using, when the receive is 
complete, A+ attempts to write to the specified file 
or into an incremented filename. A+ may overwrite 
the previous data in the specified file, depending 
on the filename.

Switches:

◗ -N= Allow transparent data to be received “as 
is” (no translation).

◗ -T= Force the outbound data through the 
translation table.

VOICE Hangs up the phone and terminates a session. 
Usually, the command to terminate the Cleo 
3780Plus application (QUIT) follows this 
command.

 (Contd)
Command Description
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Introduction

Welcome Welcome to Sterling Gentran:Server, the electronic data interchange (EDI) 
software that makes it easy to manage data exchanges between you and your 
trading partners. The heart of EDI is the translation of data into and out of formats 
that are intelligible to computerized data management systems. 

Sterling Gentran:Server enables you to exchange data with your trading partners. 
When you send application data, Sterling Gentran:Server converts your data into 
EDI standard formats that can be understood by your trading partners. When you 
receive data in a standardized format, Sterling Gentran:Server translates the data 
into a format your application can understand.

You can use Sterling Gentran:Server to describe your applications, edit standards, 
maintain trading partnership information, and generate translation “maps,” which 
are sets of instructions for translating data.

Note
If your company purchased the XML translation option, you can also 
exchange data in XML format. See the IBM® Sterling Gentran:Server® for 
UNIX XML User Guide for more information.

In this chapter This chapter contains background information about Sterling Gentran:Server that 
you should know before beginning to use the software.

Key terms This table describes key terms used in this chapter.

Term Description

application The business software generating the business 
information that you are sending or receiving 
electronically.

default A value that is automatically assigned.

EDI Electronic Data Interchange.

Application-to-application transfer of key business 
transaction information in a standard or XML format via a 
computer-to-computer communication link.

EDI standard A format to regulate syntax, structure, and content of 
transaction data.
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map A file that contains the relationships between:

◗ The segments and elements of a standard EDI 
document and the data fields in your application

◗ The elements in an XML document and the data 
fields in your application, EDI standard document, or 
in another XML document

◗ The segments and elements of two different 
standards

◗ The records and fields of two different applications

master directory The directory on a PC that stores your master files.

master file The version of a map that Sterling Gentran:Server uses 
to process data. 

standard format A format intelligible to computerized data management 
systems.

temporary file A file on the client that Sterling Gentran:Server uses 
during editing and compiling.

trading partner The company, division, or group with which you are 
exchanging business data electronically.

Trading Partnership An arrangement to exchange information in a specific 
document type with a specific trading partner and using a 
particular standard version.

working file A file that is stored in the user working directory on the 
client while the user has it checked out for editing.

working file directory The directory created on the client to hold the files that a 
user is editing.

 (Contd)
Term Description
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Sterling Gentran:Server Features

Introduction This summary lists the features Sterling Gentran:Server provides for your 
translation needs.

Product versions There are two basic versions of Sterling Gentran:Server:
◗ IBM® Sterling Gentran:Server® for UNIX - Workstation, which runs on a PC
◗ IBM® Sterling Gentran:Server® for UNIX, which runs on a client/server 

architecture

Sterling
Gentran:Server

Workstation
architecture

The Workstation architecture provides:
◗ A Windows® interface.
◗ All files and processing on one machine.
◗ Single-user configuration; no file-sharing or security limitations.
◗ Standard Sterling Gentran:Server functions.

Multiple Help
sources

Sterling Gentran:Server provides Help through:
◗ Wizards to guide you through the key record-creation processes.
◗ Online Help with task-oriented content.
◗ Documentation provided on CD-ROM for online access.

Automated
functions

The following features automate many tasks for you.

Archiving
◗ Stores and retrieves both EDI and user-defined data
◗ Tracks key EDI activities; provides reports and audit trails of translations

Functional Acknowledgments
◗ Handles inbound and outbound functional acknowledgments and 

reconciliation
◗ Provides status information for each document

Task Scheduler
◗ Runs processes such as upload and download, translation, communications, 

and other tasks in a totally unattended mode
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Mappers The Application Integration system is available in Sterling Gentran:Server.
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Sterling Gentran:Server Architecture

Introduction This topic describes the IBM® Sterling Gentran:Server® for UNIX - Workstation 
architecture.

Description All Sterling Gentran:Server files are installed on a PC. The PC stores the data, 
houses the user interface, and runs the processes. 

Advantages The Workstation architecture provides the following advantages:

◗ Allows users familiar with PCs to quickly learn how to use the Sterling 
Gentran:Server interface

◗ Provides a single-user control over data and processes
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Running Multiple Sessions

Definition A session is a single instance of the Sterling Gentran:Server application running 
in a window on your desktop.

Sterling Gentran:Server does not limit you to a single session; you can run more 
than one instance of IBM® Sterling Gentran:Server® for UNIX client software or 
IBM® Sterling Gentran:Server® for UNIX - Workstation at the same time. Each 
time you start Sterling Gentran:Server on your desktop, you start a new session. 
Each session runs in a different window. Running multiple sessions enables you 
to perform different Sterling Gentran:Server tasks in each window.

How many
sessions can

you run?

You can run:

◗ Up to four sessions of the IBM® Sterling Gentran:Server® for UNIX client 
software at the same time on one Windows desktop

◗ Up to four sessions of IBM® Sterling Gentran:Server® for UNIX - Workstation 
at the same time on one Windows desktop

◗ IBM® Sterling Gentran:Server® for UNIX - Workstation and IBM® Sterling 
Gentran:Server® for UNIX client software at the same time on one desktop.

Example
You run three simultaneous sessions of the Sterling Gentran:Server client 
software for the host1 and environment XYZ combination:

◗ Session 1, view a file with the File Browser
◗ Session 2, search for a Trading Partnership record
◗ Session 3, create a new category

Performance
limitations

Each additional session you start degrades performance. Opening too many 
sessions at once can cause the client to lock.

Login
requirements for

UNIX

When you start another Sterling Gentran:Server session for a host and 
environment that is running on your desktop, you must use the same User Name 
and Password to log onto the new session.

If you want to start a session for a different host or environment, you can use a 
different User Name and Password.
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Process and
session limits

If you open multiple sessions on your desktop, the sessions can be for the:

◗ Same host and environment (IBM® Sterling Gentran:Server® for UNIX)
◗ Same host and different environments (IBM® Sterling Gentran:Server® for 

UNIX)
◗ Different hosts and environments (IBM® Sterling Gentran:Server® for UNIX)
◗ Combination of IBM® Sterling Gentran:Server® for UNIX - Workstation 

sessions and IBM® Sterling Gentran:Server® for UNIX sessions.

This table shows the limitations on running processes in multiple sessions.

If a process has session limitations and is already running, Sterling 
Gentran:Server displays a message to let you know that the process is busy and 
asks that you try again later.

Process Limitations

File Browser None. Multiple windows permitted in each 
session.

Trading Partnership Maintenance None. Multiple windows permitted in each 
session.

Process Control Manager Once in a session for each host/
environment combination.

SAP Configuration (if purchased) Once in a session for each host/
environment combination. 

Archive Once in a session for each host/
environment combination.

EC Workbench server One client session for each host/
environment combination.

You can run EC Workbench multiple times 
as long as each Client session is for a 
different host/environment combination.

Translation One client session for each host/
environment.

You can run translation multiple times as 
long as each session is for a different host/
environment combination.

Map Compilation One client session at a time.

Mapping None. Multiple windows permitted in each 
session 
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File locking Sterling Gentran:Server locks certain files to prevent you from editing the same 
file in multiple sessions. If you attempt to edit a file that you are editing in another 
session, Sterling Gentran:Server displays a message to let you know that the file 
is in use.

Sterling Gentran:Server locks these files when you open them for editing:

◗ Maps
◗ Trading Partner record
◗ Group Organization record
◗ Interchange Organization record

Exceptions
Locking does not apply to:

◗ Files edited in the File Browser
◗ Trading Partnership Category files
◗ Trading Partnership Contact files

Note
If the same non-DISAM file is edited in two different parallel sessions, the 
last changes saved overwrite earlier changes from another session.

Caution
Never use the File Browser to edit a DISAM (*.dat and *.idx pair) file. Doing 
so will corrupt the file. 

Report, log and
local temporary

files

Sterling Gentran:Server keeps the report files, log files, and local temporary files 
for each host and environment in different directories.

The system creates a directory named rpt for the report and log files under the 
directory where the Sterling Gentran:Server client software is installed. The local 
temporary working files are stored in the lcltmp directory.

For each host and environment, the system creates a subdirectory under the rpt 
and lcltmp directories. The subdirectory is named for the environment and host 
name (environment+hostname) logged in to for the session.
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Example
The Sterling Gentran:Server client software is installed in D:\gentran. The 
system creates subdirectories for the report files and for the local temporary 
files:

◗ D:\gentran\rpt
◗ D:\gentran\lcltmp
You start a session, logging in to the 60test environment on the host 
hpd350. Sterling Gentran:Server creates subdirectories for the session:

◗ D:\gentran\61testhpd350
◗ D:\gentran\rpt\61testhpd350
◗ D:\gentran\lcltmp\61testhpd350

Sterling Gentran:Server stores the session report and log files in 
D:\gentran\rpt\61testhpd350 and stores the session local temporary files in 
D:\gentran\lcltmp\61testhpd350.

You open a session for a different environment and host, 2XF on hpd001. Sterling 
Gentran:Server creates new subdirectories for the report and local temporary 
files:

◗ D:\gentran\2XFhpd001
◗ D:\gentran\rpt\2XFhpd001
◗ D:\gentran\lcltmp\2XFhpd001

Note
If the host or environment name contains special characters (such as *, ?, 
<, or >), the system converts the special characters to underscores (_). For 
example, the host name hp<200> is converted to hp_200_.
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File Name Conventions

Introduction This topic describes the file name conventions and limitations you must follow 
when you name a Sterling Gentran:Server file or directory.

Directory and
path name

length

Directory names can be up to 63 characters in length, not counting the slash or 
backslash character used to separate a directory name from a subdirectory name.

The total maximum for a path, file name, and file name extension is 128 
characters.

Validation When you save or open a file, Sterling Gentran:Server checks the length of the file 
name and the characters used in the file name. If the file name exceeds the 
maximum length or if the file name includes an invalid character, Sterling 
Gentran:Server displays a message to alert you of the problem.
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File name length This table lists length restrictions of the file names of specific types of Sterling 
Gentran:Server files:

File Type Maximum Length of Name

Map 60 (plus 4-character extension)

File definition 60 (plus 4-character extension)

Application description 60 (plus 4-character extension)

Implementation guide 60 (plus 4-character extension)

Input file 60 (plus 4-character extension)

Output file 60 (plus 4-character extension)

Mapping table 60 (plus 4-character extension)

Script 14 characters

Data manager 4 characters

Data manager pattern 15 characters

Transaction Register 9 characters

Queue 8 characters
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Character
limitations

This table lists the characters that Sterling Gentran:Server does not allow in a file 
name.

Character Description

\ Backslash (reserved for separating directory, subdirectory, and 
file names)

/ Slash (reserved for separating directory, subdirectory, and file 
names)

* Asterisk

“ Double quotation mark

‘ Forward single quotation mark

' Backward single quotation mark

< Less-than sign

> Greater-than sign

| Vertical bar

Spaces

@ “At” sign

& “Ampersand” character

( Open round bracket

) Closed round bracket

; Semi-colon

: Colon

? Question mark

$ Dollar sign
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Introduction

In this chapter This chapter contains general information about the Sterling Gentran:Server 
interface. It describes the menus and Toolbar of the Main Window and includes 
instructions for:

◗ Starting and exiting Sterling Gentran:Server
◗ Using menus, toolbar buttons, and dialog boxes
◗ Using the File Browser to edit text, EDI, and NCPDP files
◗ Choosing printing properties
◗ Setting Sterling Gentran:Server preferences and default values

Key terms This table describes key terms used in this chapter.

Term Description

check box A square to the left of an option in a dialog. When the 
option is selected, the square contains an X. You click 
the check box to change whether the option is selected. 

default A value that is automatically assigned.

master directory The directory on a PC  that stores your master files.

menu A list of related commands.

menu bar The row of menu names that runs across the top of a 
window.

option button A round button used to select one option from a mutually 
exclusive set of options.

push-button A symbol or icon that initiates some action when you 
click it.

text box A box into which you enter alphanumeric text to provide 
data needed by Sterling Gentran:Server.

Toolbar A bar of buttons used to start commands.
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Starting and Exiting 0

How to Start Sterling Gentran:Server

Introduction This topic explains how to start Sterling Gentran:Server.

Note
You can run up to four sessions of Sterling Gentran:Server on the same 
desktop at once.

Procedure Follow this procedure to start Sterling Gentran:Server. 

Reference
See the How to Set TP Administration Preferences topic in the IBM® 
Sterling Gentran:Server® for UNIX Application Integration User Guide for 
instructions on setting Trading Partnership Administration Preferences.

Step Action

1 Click the Windows Start menu.

2 Select the Sterling Gentran:Server program icon from the 
Programs menu.

System Response
Sterling Gentran:Server displays the copyright dialog box.

3 Click OK.

System Response
Sterling Gentran:Server displays the Main Window.
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How to Exit Sterling Gentran:Server

Introduction This topic explains how to exit Sterling Gentran:Server.

Before you exit Any files that are checked out when you exit the application remain checked out 
and unavailable for other users to edit. Before you exit Sterling Gentran:Server, 
be sure to check in any files that you no longer need. 

Reference
See How to Check In Maps and Translation Objects and How to Check In 
File Definitions in the Working with Application Integration chapter.

Procedure Select Exit from the File menu.

Note
If you are running multiple sessions on your desktop, you must exit each 
session.

System Response
Sterling Gentran:Server exits.
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The Sterling 
Gentran:Server User 
Interface 0

Overview

Introduction Sterling Gentran:Server features on the client use the Windows environment. To 
use Sterling Gentran:Server, you must be familiar with using a personal computer 
and with Windows functions and terminology, including the following:

◗ The terminology used to describe mouse and cursor actions; for example, 
opening, clicking, scrolling

◗ The terminology used to describe Windows-specific attributes, such as dialog 
boxes, buttons, and check boxes.

User interface The user interface for all versions of Sterling Gentran:Server includes:

◗ Screens that use the familiar Windows interface.
◗ Graphical tree organization of trading partnership records to make setup and 

maintenance easier.
◗ Graphic displays of mapping components and relationships.
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The Main Window

Introduction This topic explains the items you see on the Sterling Gentran:Server Main 
Window.

Reference
Refer to your Windows documentation for detailed explanations of Windows 
terms and functions.

Main
Workstation

window

This illustration shows the major parts of the main window for Sterling 
Gentran:Server. 

Menu bar
Toolbar

Status
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Parts of the
window

This table describes the parts of the main Sterling Gentran:Server window.

Part Function

Menu bar Opens menus to display commands.

Toolbar Starts commands from a set of buttons.

Status bar Displays a status message, prompt, or toolbar button description.
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Main Window Menus

Introduction You can start all Sterling Gentran:Server features and functions from the menus of 
the Sterling Gentran:Server Main Window.

Workstation
Main Window

menus

This table describes the menus of the Workstation Main Window.

Menu Used to…

File Menu ◗ Check in a file
◗ Check out a file
◗ Unlock a file
◗ Open the Print Setup dialog box
◗ Exit the Main Window

Edit Menu ◗ Start a mapping editor
◗ Start the Trading Partnership 

Administration system

Translate ◗ Open the Translate Documents dialog box
◗ Generate a translation report.

Archive ◗ Set archiving parameters
◗ Open an archive
◗ Purge an archive
◗ Load and unload archived files
◗ Create new archives

XML Configuration (if you 
purchased the XML 
translation option)

◗ Open the XML Element Configuration 
window

◗ Start the XML Trading Partnership Rules 
wizard

◗ Open the XML TP Cross Reference dialog 
box.

Application File Configuration ◗ Start the Application File Trading 
Partnership Rules wizard

◗ Open the Application File TP Cross 
Reference dialog box.
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Tools ◗ Set up and Run scheduled tasks
◗ Run Standard Version Conversion
◗ Start the File Browser
◗ Open the Run a Command dialog box to 

run a command line program

Settings Specify default directories for your Sterling 
Gentran:Server files

Window ◗ Display or hide the Toolbar
◗ Display or hide the Status Bar

Help ◗ Open the Help Contents or Index
◗ Display information about using Help
◗ Display version information for Sterling 

Gentran:Server

 (Contd)
Menu Used to…
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The Main Window Toolbar

Introduction The Sterling Gentran:Server Toolbar consists of several buttons that you can use 
to quickly access Sterling Gentran:Server systems, tools, and optional features.

The specific buttons displayed on your toolbar depend upon the Sterling 
Gentran:Server product and options your company purchased. This topic 
describes the most common buttons. Your toolbar may include additional buttons 
for optional features.

The Main
Window Toolbar

To execute a command with a toolbar button, click the appropriate button. 

Click this… To do this…

Check in files.

Check out files.

Open the Application Integration mapping editor.

 

Open the Trading Partnership Administration system.

Open the Translate Documents dialog box or generate a 
translation report.

Start an archiving option.

Open the File Browser text editor.

Display Help for the current window.
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How to Use the Sterling Gentran:Server Interface

Introduction This topic explains how to use the Sterling Gentran:Server menus, toolbars, 
dialog boxes, and other interface features.

Using the
Toolbar

To start a feature or system from the Toolbar, click the appropriate Toolbar 
button.

Note
For information about a Toolbar button, place the pointer on the button to 
display the button name and then refer to the Status Bar for the button 
function.

Using the Status
Bar

The status bar displays information, descriptions, or instructions for the active 
window, item on a dialog box, toolbar button, or command. You may see a status 
such as “Ready” for a window, an instruction such as “Enter record ID” for a text 
box on a dialog box, or “File Browser” for a Toolbar button.

To use the Status Bar, move the pointer to the window, box, or button that you 
want to check and then read the text displayed on the Status Bar.

Using dialog
boxes

You enter information within a dialog box by:

◗ Typing in text boxes
◗ Selecting items from list boxes
◗ Clicking check boxes, options, or push buttons. 

To move to the desired box or button, use either the mouse or the keyboard.

◗ When using the mouse, move the mouse pointer to the desired box or button 
and click to select the box or button.

◗ When using the keyboard, press TAB to move to the next box or button or 
press SHIFT+TAB to move to the previous box or button.

Status bar
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How to Use the On-line Help

Introduction Sterling Gentran:Server provides Help information to guide you through 
commands and procedures. Sterling Gentran:Server Help files explain many 
topics: parts of the active window, commands, dialogs, and procedures for using 
specific features to perform a task.

Getting Help You can access Help several ways. The methods available depend on the window 
you have displayed. 

Using the Help
menu

To learn how to use Help, select Using Help from the Help menu. 

The Contents command form the Help menu displays a list of Help topics that you 
can choose from. You can access Help information for the topics in different ways; 
you can use the menus at the top of the Help window, or you can use the buttons 
under the menus to search for a topic. You can print and edit Help information.

To start Help 
from… Do this…

The menu bar Select a command or topic from the Help menu. 

The toolbar Click the Help button on the toolbar for information about 
the currently displayed dialog box or window. 

Any window Press F1 for information about the window. 

A dialog box Click the Help button on the active dialog box for related 
help information. 
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Using the Help
toolbar button

On major windows, you can get window-level Help by clicking the Help button on 
the toolbar. 

Using the Help
buttons on

dialog boxes

You can get Help for any dialog box that displays the Help button. Click Help for 
more information. 

Exiting Help You can close the Help window when you are finished with it. To close Help, 
select Exit on the File menu of the Help system menu bar.

Help
Getting Started Guide – May 2011



The File Browser Using Sterling Gentran:Server4 - 14
The File Browser

Introduction The File Browser is a Sterling Gentran:Server tool that enables you to open and 
edit text, EDI, and NCPDP files. It contains basic text-editing features, such as 
copying, cutting, pasting, finding, and replacing text.

When to use You can use the File Browser to open and edit:

◗ Text files, such as batch files (*.bat) and configuration files (*.cfg)
◗ EDI files
◗ NCPDP files

Note
When you open an EDI file in the File Browser, Sterling Gentran:Server runs 
the edifrmat command on the file before displaying it. The edifrmat 
command replaces the segment terminators in the file with new line 
terminators so that the format is easier to read.

CAUTION
Never use the file browser to edit a disam file. Doing so will corrupt 
the file.

The File Browser
window

This illustration shows the File Browser window.
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Parts of the File
Browser window

This table describes the parts and functions of the File Browser window.

Part Function

Menu bar Opens menus to display commands.

Toolbar Starts commands from a set of buttons.

Status bar Displays a status message, prompt, or toolbar button 
description.
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How to Use the File Browser

Introduction This topic explains how to start and exit the File Browser, open a file, and use the 
File Browser editing commands to modify a file.

Starting the File
Browser

To start the File Browser, do one of the following:

◗ Click the File Browser button on the Main Window toolbar.
◗ Select Start File Browser from the Tools menu.

Opening a file There are two ways to open a file in the File Browser: from the Toolbar or from the 
File menu.

Method 1 - Toolbar button.

Step Action

1 Click the Open button on the File Browser toolbar.

System Response
The File Browser displays the Open dialog box.

2 Select Text File, EDI File, or NCPDP File to indicate the type of file 
you want to open.

CAUTION
Never use the file browser to edit a disam file. Doing so 
will corrupt the file.

3 Click OK.

System Response
The File Browser displays the standard Open dialog box.

4 Browse to the folder and file you want to open.

5 Click OK.
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Method 2 - File menu

Select Open from the File menu and then select Text, EDI, or NCPDP from the 
cascading menu.

Editing a file in
the File Browser

This table describes how to edit, print, and save a file in the File Browser.

6 IF you open… THEN the File Browser…

an EDI file displays the Enter EDI Format 
Parameter dialog box.

Continue with Step 7.

a text file displays the text file. You are 
finished. 

a NCPDP file runs the edifrmat command on 
the file you selected and 
displays the file in a newline 
terminated format.

You are finished.

7 Select the option on the Enter EDI Format Parameter dialog box to 
specify the format you want applied to the data.

System Response
The system runs the edifrmat command on the file you 
selected and displays the file in a newline terminated format.

 (Contd)
Step Action

IF you want to… Then…

Insert characters Click at the insertion point and type the 
characters.

Copy selected text to the 
clipboard

Click Copy on the Edit menu.

Paste text on the clipboard 
into the document

Click at the insertion point and then click Paste 
on the Edit menu.

Select the entire document Click Select All on the Edit menu.

Search for characters, words, 
or phrases

Click Find on the Edit menu. Then, enter the 
search string.
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Exiting the File
Browser

To close the File Browser, do one of the following:

◗ Select Exit from the File menu.
◗ Click the close button on the File Browser window.

Search for the next 
occurrence of a search item

Click Find Next on the Edit menu.

Replace selected text Click Replace on the Edit menu. Then type the 
replacement text.

Print the document Click Print on the File Menu.

Save the changes to the 
document

Click Save on the File menu.

Save a copy of the document 
under a new path or name

Click Save As on the File menu. and enter the 
new path and file name.

 (Contd)
IF you want to… Then…
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How to Change Print Properties

Introduction This topic explains how to open the Print Setup dialog box from within Sterling 
Gentran:Server. Check your Microsoft documentation for details on how to use 
the window.

Background When you print any of the reports that Sterling Gentran:Server generates, the 
program prints the report on the default printer, using the default font style and 
size specified for that printer. You can use the Microsoft Print Setup dialog box to 
specify print properties for the default printer for the client. 

Your selections affect all printing (except printing of compiler messages) in 
Sterling Gentran:Server until you quit or change them. If you want to set these 
defaults and keep them between Sterling Gentran:Server sessions, use the 
Printers utility in the Windows Control Panel.

Opening the
Print Setup

window

Follow this procedure to open the Print Setup dialog box from within Sterling 
Gentran:Server.

Adjusting print
properties

Depending upon the font style and size, some parts of the report may not appear 
on the output (This may be a problem with fonts larger than 12 point). To correct, 
change the default font style or size. The methods of changing the default font 
style and size vary according to your PC. 

Depending upon the aspect ratio of the report, you could also try printing 
landscape instead of portrait. 

Step Action

1 Click File on either the Main, Application Integration Main, 
Application Editor, or Standard/IG Editor menu bar.

2 Click Print Setup on the File menu.
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Setting Default Values 0

Overview

In this section This section explains how to set the basic directory for the Application Integration 
system and default values you want your system to use.

Reference
See the Setting Preferences and Default Values section in the IBM® 
Sterling Gentran:Server® for UNIX Application Integration User Guide for 
information about setting preferences and default values for the Application 
Integration system.

Default
directories

The Set Up Directories dialog box enables you to define the default directories 
that Sterling Gentran:Server will use to store your Sterling Gentran:Server files on 
your PC or client. 

When to set the
values

We recommend that you set your default directory and map display values before 
you create your first map. However, you can set or change the map display 
options at any time.
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Where to go next Use this table to locate the instructions for setting particular types of preferences.

IF you want to customize… THEN select…

Workstation

The default directories your 
system uses to store Sterling 
Gentran:Server files

How to Change the Default Workstation 
Directories

Application Integration

All the Application Integration 
system preferences

How to Set the Application Integration 
Preferences in the IBM® Sterling 
Gentran:Server® for UNIX Application 
Integration User Guide.

The list of date and time 
formats that you can use in 
map fields

How to Set the Application Date/Time Formats 
in the IBM® Sterling Gentran:Server® for 
UNIX Application Integration User Guide.

The default date format for all 
date fields used in a map

How to Set the Default Date Formats in the 
IBM® Sterling Gentran:Server® for UNIX 
Application Integration User Guide.

Which map component 
descriptions are displayed

How to Customize Component Display 
Options in the IBM® Sterling Gentran:Server® 
for UNIX Application Integration User Guide.

Foreground and background 
colours of map components

How to Customize Component Colors in the 
IBM® Sterling Gentran:Server® for UNIX 
Application Integration User Guide

Font type, style, or size used 
in map displays

How to Customize Global Fonts in the IBM® 
Sterling Gentran:Server® for UNIX Application 
Integration User Guide.

How map links are displayed How to Customize the Display of Links in the 
IBM® Sterling Gentran:Server® for UNIX 
Application Integration User Guide.

How the map version number 
is incremented

How to Customize the Auto-increment Map 
Version in the IBM® Sterling Gentran:Server® 
for UNIX Application Integration User Guide.
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Set Up Directories Dialog Box

Introduction The Set Up Directories dialog box enables you to define the default directories 
that Sterling Gentran:Server will use to store your Sterling Gentran:Server files on 
your PC.

Sterling
Gentran:Server

Workstation

This illustration shows the Set Up Directories dialog box for IBM® Sterling 
Gentran:Server® for UNIX - Workstation.
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Fields and
functions

This table lists the fields of the Workstation Set Up Directories dialog box and their 
functions.

Field Function

Standards Stores a list of available standards. 

Implementation Guide Stores implementation guides (.igs). 

File Definitions/Apps Stores file definitions (.ddfs). 

Maps Stores map files and translation objects. 

Trading Partner 
Records

Stores Trading Partnership files. 

EDI Status Audit Stores the status audit files that Sterling 
Gentran:Server generates. 

EDI History Audit Stores the history audit files that Sterling 
Gentran:Server generates. 

User Files Stores your user files. 

Text/Help Files Stores text files and the Sterling Gentran:Server Help 
files. 

Data Files Stores your data files. 

Report/Log Contains the reports and log files that Sterling 
Gentran:Server generates. 

Default Check In/Out Serves as the default working directory for files. 

Default TPL/TBL 
Location

Serves as the default working directory for translation 
objects (compiled maps). 
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How to Change the Default Workstation Directories

Introduction You can change the default directories for the Sterling Gentran:Server files from 
the values set at installation. 

Changing
Workstation

directories

Use this procedure to change a directory path for the Sterling Gentran:Server 
Workstation files.

Step Action

1 Click Settings on the menu bar.

2 Click Set Up Directories on the Settings menu.

System Response
The system displays the Set Up Directories dialog box.

3 Click in the appropriate text box.

4 Delete the current path and type the new path, or edit the existing 
path as appropriate.

Note
You can use the browse button to the right of the box to 
browse for the path.

5 Click OK to save your changes. 
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Overview 0

Introduction

In this chapter This chapter contains information about working in Workstation and accessing 
and returning files.

Key terms This table describes the key terms used in this chapter.

Term Description

check in The act of returning a copy of a file from your 
working directory to the master directory, 
making it available to other users.

check out The act of copying a file from the master 
directory to your working directory, making the 
file unavailable to other users.

lock The act of making a file unavailable to other 
users. A file is locked once it is checked out.

unlock The act of making a file available to other 
users. A file is unlocked once it is checked in.
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Working in Workstation

Introduction IBM® Sterling Gentran:Server® for UNIX - Workstation uses numerous data files 
such as maps, translation objects (.TPL files), file definitions (.ddf files), and 
Trading Partnership records.

This section explains how to work with files in Sterling Gentran:Server.

Master directory Sterling Gentran:Server stores the master files (maps, translation objects, file 
definitions, etc.) on the PC in the master directory specified for the file type. You 
specify the master directories in the Set Up Directories dialog box, which is 
available from the main Sterling Gentran:Server window under the Settings menu.

File checkout When you want to edit a master file, you must check it out. When you check out a 
map file to edit it, Sterling Gentran:Server moves a copy of the file to the working 
directory and retains the original file in the master directory.

Working
directory

Sterling Gentran:Server stores your working files (copies of checked out maps 
and file definitions) in the working directory on the PC. This enables you to modify 
a checked-out map without affecting the original file. You specify the working 
directories in the Set Up Directories dialog box, which is available from the 
Sterling Gentran:Server Settings menu.

Map check in When you check in a map file, Sterling Gentran:Server transfers a copy of the file 
from your working directory to the master directory. If the map file is one that you 
checked out, Workstation replaces the map in the master directory with the 
working copy. The working copy becomes the new master file for the map. 
Sterling Gentran:Server lets you to choose to keep or remove the copy of the file 
in your working directory.
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Dialog Boxes 0

Select Map and File Definitions Files to Check out 
Dialog Box

Introduction This topic describes the following dialog boxes:

◗ Select Map Files to Check out
◗ Select File Definition Files to Check out

Purpose The Select <filename> to Check out dialog box is used to move a copy of a file 
from the master directory to a working directory on the PC. Maps, and their 
associated TPL files, and file definitions files can be checked out.

Example check
out dialog box

The same dialog box format is used to check out file definition files.

This illustration shows the Select Map Files to Check out dialog box.
Getting Started Guide – May 2011



Working with Application Integration Select Map and File Definitions Files to Check out Dialog Box 5 - 5
Fields and
functions

This table lists the fields of the Select Map Files to Check Out and Select File 
Definition Files to Check out dialog box and their functions.

Field Function

 …files from Displays the name of the master directory.

The list below the name displays the names of the files 
in the master directory. An asterisk next to a name 
indicates that the file is currently checked out.

Check out <filename> 
files to

Displays the name of the default working directory on 
your PC. This is the directory to which Sterling 
Gentran:Server copies the file.

The list below the directory name displays the names 
of the working files in the working directory.

Note
You can use the browse button to select a different 
directory.

Add Adds the name of the selected file to the list of files in 
the working directory.

Remove Removes the name of the file from the working 
directory check out list.

Add All Adds the names of all the files in the master directory 
to the working directory.

Remove All Removes the names of all the files from the working 
directory check out list.

Edit Mode Checks out the files so that you can edit them. Copies 
the files that you added to the Check out <filename> 
files to list and moves the copies into the working 
directory. 

View Mode View Mode is unavailable in Workstation.
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Select Map Files to Check in Dialog Box

Introduction This topic describes the Select Map Files to Check in dialog box.

Purpose The Select Map Files to Check in dialog box is used to move the saved working 
file from your working directory to the master directory. The system replaces the 
master file with the map you check in. The following files can be checked in:

◗ map files 
◗ associated TPL files

Example check
in dialog box

This illustration shows the Select Map Files to Check in dialog box.
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Fields and
functions

This table lists the fields of the Select Map Files to Check in dialog box and their 
functions.

Field Function

Map files from Displays the name of the working directory on your PC.

The list below the name displays the names of the 
maps in the working directory.

Note
You can use the browse button to select a 
different directory.

Check in Map files to Displays the name of the master directory for maps on 
your PC. This is the directory to which Sterling 
Gentran:Server copies the map file.

The list below the directory name displays the names 
of the maps in the master directory.

Add Adds the name of the selected map to the list of maps 
in the master directory.

Remove Removes the name of the map from the master 
directory check in list.

Add All Adds the names of all the maps in the working 
directory to the master directory.

Remove All Removes the names of all the maps from the master 
directory check in list.
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Select TBL/TPL Files to Check In Dialog Box

Introduction The Select TBL/TPL Files to Check In dialog box is used to select the translation 
objects (compiled maps)  you want to check in.

Illustration This illustration shows the Select TBL/TPL Files to Check In dialog box.

Fields and
functions

This table lists the fields of the Select TBL/TPL to Check In dialog box and their 
functions.

Field Function

List of Map files to 
check in from 
directory

Displays the name of the working directory on your PC.

The list below the name displays the names of the 
maps you are checking in.

List of associated 
TBL/TPL files to 
check in with

Displays the names of the translation objects 
associated with the maps you are checking in. 

Finish Saves your changes and checks in the maps and 
translation objects you selected.
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Select File Definition to Check in Dialog Box

Introduction The Select File Definition Files to Check in dialog box is used to move a working 
copy of a file definition file (.ddf) from your working directory to the master 
directory for file definitions.

Illustration This illustration shows the Select File Definition Files to Check in dialog box.

Note
When you check in a file, the system converts the filename to lowercase letters. 
UNIX client/server versions require that the filenames are lowercase.
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Fields and
functions

This table lists the fields of the Select File Definitions to Check in dialog box and 
their functions.

Field Function

File Definition files 
from

Displays the name of the working directory.

The list below the name displays the names of the file 
definition files in the working directory. An asterisk next 
to a name indicates that the file is currently checked 
out.

Note
You can use the browse button to select a different 
directory.

Check in File 
Definition files to

Displays the name of the master directory for file 
definition files. This is the directory to which Sterling 
Gentran:Server copies the file.

The list below the directory name displays the names 
of the file definition files in the master directory.

Add Adds the name of the selected file definition file to the 
list of file definition files in the master directory.

Remove Removes the name of the file definition file from the 
master directory check in list.

Add All Adds the names of all the file definition files in the 
working directory to the master directory.

Remove All Removes the names of all the file definition files from 
the master directory check in list.

Check in and Remove Saves your changes, starts moving the file definition 
files, and deletes the working copies from the working 
directory.

Check in and not 
Remove

Saves your changes, starts moving the file definition 
files, and retains the working copies in the working 
directory.
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Select Map and File Definition Files to Unlock Dialog 
Box 

Introduction This topic describes the following dialog boxes:

◗ Select Map Files to Unlock
◗ Select File Definition Files to Unlock

Purpose The unlock dialog box is used to remove the lock from the master file when you 
do not want to save changes to a file in your working directory. The following files 
can be unlocked:

◗ map files
◗ file definitions files

Example unlock
dialog box

The same dialog box format is used to unlock file definition files.

This illustration shows the Select Map Files to Unlock dialog box.
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Fields and
functions

This table lists the fields of the Select Map Files to Unlock dialog box and their 
functions.

Field Function

…files from Displays the name of the working directory.

The list below the name displays the names of the files 
in the working directory. An asterisk next to a name 
indicates that the file is currently checked out.

Notes
You can use the browse button to select a different 
directory.

Selected <filename> 
files to unlock in

Displays the name of the master directory for the files. 
This is the directory to which Sterling Gentran:Server 
copies the file.

The list below the directory name displays the names 
of the files in the master directory.

Add Adds the name of the selected file to the list of files in 
the master directory.

Remove Removes the name of the file from the master directory 
unlock list.

Add All Adds the names of all the files in the working directory 
to the master directory.

Remove All Removes the names of all the files from the master 
directory unlock list.

Unlock Unlocks the file or files you have selected
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Procedures 0

How to Check Out and View Maps and File Definitions

Introduction This topic explains how to check out a file. 

What happens
when you check

out a file

When you check out a file in Sterling Gentran:Server, Sterling Gentran:Server 
copies the file from the master directory to the working directory on the PC.
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Checking out a
map or file

definition

Use this procedure to check out a map or a file definition file in Workstation.

Step Action

1 Select Check Out from the Sterling Gentran:Server Main File menu 
and click the type of file you want to check out.

◗ Map
◗ File Definition File

System Response
Sterling Gentran:Server displays the Select <filename> Files 
to Check out dialog box.

Notes
An asterisk next to a file name indicates that the file is 
already checked out.

The View Mode button is unavailable in Workstation.

2 Check the name of the default directory to which the system will 
copy checked out files. Do you want to check out files to a different 
directory?

◗ If YES, click the directory button and browse to the directory; 
continue with the next step.

◗ If NO, continue with the next step.
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3 Use this table to determine your next step.

IF you want to check out… THEN…

a single file Select the file you want to check 
out from the list in the left pane 
and click Add.

Repeat this step for each 
additional file you want to check 
out.

4 all the available files Click Add All.

5 Click Edit Mode.

System Response
Sterling Gentran:Server displays the Check-out <filename> 
File Status dialog box.

6 Do you want to print the information displayed on the Check-out 
<filename> File Status dialog box?

◗ If YES, click the Print.
◗ If NO, click Close.

 (Contd)
Step Action
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How to Save Changes to Working Files

Introduction If a an Application Integration system map file is open, you can save changes on 
the PC:

◗ To the open file
◗ To the working copy of a map (but not to the original map)

Note
You can also save the map files by using a new file name.

Reference
To replace an original map with a working copy of the map that you have 
modified, see How to Check In Maps and Translation Objects  in this 
chapter.

Saving changes
to an open file

Use this procedure to save changes to an open file.

Procedure 
Click Save on the File menu. 

System Response
Sterling Gentran:Server updates the file.
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Saving to a new
file name

Use this procedure to save an open working map file to a new file name in the 
working directory.

CAUTION
You cannot use this procedure to save a working map file to the 
master directory.

Step Action

1 Click Save As on the File menu. 

System Response
Sterling Gentran:Server displays the Save As dialog box.

2 Type the new file name for the copy of the map.

Note
You cannot save a map file to another directory, but you can 
save it under a new file name.

Reference
See How to Check In Maps and Translation Objects in this 
chapter to replace a master map file with a modified working 
copy.

3 Click OK.

System Response
Sterling Gentran:Server saves a copy of the map under the 
new name.
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How to Unlock Master Files and Delete Working Copies

Introduction If you do not want to save changes to a file in your working directory, you can use 
the Sterling Gentran:Server Unlock function to remove the lock from the master 
file and delete the working copy of the file. This procedure explains how to use the 
Unlock function.

CAUTION
When you unlock a master file, you lose all changes you made to the 
working file. Use this procedure only if you want to delete the 
working file.

Procedure Use this procedure to unlock a master file and delete a working file.

Step Action

1 Select Unlock from the File menu and click the type of file you want 
to unlock:

◗ Map
◗ File Definition File

System Response
Sterling Gentran:Server displays the Select <filename> Files 
to Unlock dialog box.
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2 Use this table to determine your next step.

IF you want to unlock… THEN…

a single file Select the file you want to remove 
from the list of available files in the left 
box and click Add.

System Response
Sterling Gentran:Server moves 
the selected file to the selected 
files to unlock list.

all the available files Click Add All.

System Response
Sterling Gentran:Server moves 
all the files to the selected files 
to unlock list.

3 Click Unlock.

System Response
Sterling Gentran:Server displays this dialog box.

 (Contd)
Step Action
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4 Do you want to continue?

◗ If YES, click Yes.
◗ If NO, click No.

System Response
If you clicked Yes, Sterling Gentran:Server displays the 
Unlock <filename> File Status dialog box.

5 Do you want to print the information displayed on the Unlock 
<filename> File Status dialog box?

◗ If YES, click the Print.
◗ If NO, click Close.

 (Contd)
Step Action
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How to Check In Maps and Translation Objects

Introduction This topic explains how to check in maps and the translation objects (TPL 
files)associated with them.

What happens
when you check

in a file

When you are satisfied that a working map and translation object produces the 
results you expect, you check in the working file. When you check in a working 
file, the system copies the file from the working directory to the master directory, 
replacing the original file. The working file becomes the new map or translation 
object. You can choose to leave a copy of the file in the working directory or 
remove it.

Maps The procedure for checking in maps differs from that for checking in other files 
because you can check in multiple maps at the same time.

You can check in a compiled working map or an uncompiled working map.
◗ If you compile a working map before you check it in, the Check In function 

moves the compiled map to the master directory.
◗ If you move an uncompiled working map, you must compile it in the master 

directory; otherwise, the translator will not recognize the changes.
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Checking in
maps and

translation
objects

Use this procedure to check in a map and translation object.

Step Action

1 Select Check In from the Sterling Gentran:Server Main File menu 
and click Map.

System Response
Sterling Gentran:Server displays the Select Map Files to 
Check in dialog box.

2 Use this table to determine your next step.

IF you want to check in… THEN…

a single map Select the map you want to 
check in from the list in the left 
pane and click Add.

Repeat this step for each 
additional map you want to 
check in.

 all the available maps Click Add All.
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3 Click Next.

System Response
Sterling Gentran:Server searches for the associated 
translation object files in the default Table Location directory 
and displays the results in the Select TBL/TPL Files to Check 
In dialog box.

4 Do you want Sterling Gentran:Server to search for the translation 
object in a different directory?

◗ If YES, click the browse button next to specify the directory; 
continue with next step.

◗ If NO, continue with Step 5.

5 Do you want to check in the translation object associated with the 
map you are checking in?

◗ If YES, make sure that the check box next to the translation 
object is selected and then click Finish.

◗ If NO, clear the check box and then click Finish.

System Response
Sterling Gentran:Server displays this dialog box.

 (Contd)
Step Action
Getting Started Guide – May 2011



How to Check In Maps and Translation Objects Working with Application Integration5 - 24
6 Do you want to remove the copies of the working files from the 
working directory after the files are checked in?

◗ If YES, click the Yes button.
◗ If NO, click the No button.

System Response
The system displays the Check-in Map and TBL/TPL File 
Status dialog box.

7 Do you want to print the information displayed on the Check-in 
<filename> Status dialog box?

◗ If YES, click the Print.
◗ If NO, click Close.

 (Contd)
Step Action
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How to Check In File Definitions 

Introduction When you are satisfied with a file definition file, you check in the working file. 
When you check in a working file, the system copies the file from the working 
directory to the master directory, replacing the original file. The working file 
becomes the new file definition. You can choose to leave a copy of the file in the 
working directory or remove it.

Checking in a file
definition

Use this procedure to check in a file definition file.

Step Action

1 Select Check In from the Sterling Gentran:Server Main File menu 
and click File Definition File.

System Response
Sterling Gentran:Server displays the Select File Definition 
File to Check in dialog box.
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2 Use this table to determine your next step.

IF you want to check in… THEN…

a single file definition file Select the file definition  file you 
want to check in from the list in 
the left pane and click Add.

Repeat this step for each 
additional file you want to check 
in.

all the available file definition  
files

Click Add All.

3 Use this table to determine your next step.

IF you want to… THEN click…

Remove the working files from 
the working directory after they 
are checked in

Check in and Remove

Leave the working files in the 
working directory after they are 
checked in

Check in and not Remove

System Response
Sterling Gentran:Server displays the Check-in File Definition 
File Status dialog box.

 (Contd)
Step Action
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2 Use this table to determine your next step.

IF you want to check in… THEN…

a single file definition file Select the file definition  file you 
want to check in from the list in 
the left pane and click Add.

Repeat this step for each 
additional file you want to check 
in.

all the available file definition  
files

Click Add All.

3 Use this table to determine your next step.

IF you want to… THEN click…

Remove the working files from 
the working directory after they 
are checked in

Check in and Remove

Leave the working files in the 
working directory after they are 
checked in

Check in and not Remove

System Response
Sterling Gentran:Server displays the Check-in File Definition 
File Status dialog box.

 (Contd)
Step Action
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4 Do you want to print the information displayed on the Check-in 
<filename> Status dialog box?

◗ If YES, click Print.
◗ If NO, click Close.

 (Contd)
Step Action
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Notices

This information was developed for products and services offered in the U.S.A. 

IBM may not offer the products, services, or features discussed in this document 
in other countries. Consult your local IBM representative for information on the 
products and services currently available in your area. Any reference to an IBM 
product, program, or service is not intended to state or imply that only that IBM 
product, program, or service may be used. Any functionally equivalent product, 
program, or service that does not infringe any IBM intellectual property right may 
be used instead. However, it is the user's responsibility to evaluate and verify the 
operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter 
described in this document. The furnishing of this document does not grant you 
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

For license inquiries regarding double-byte character set (DBCS) information, 
contact the IBM Intellectual Property Department in your country or send inquiries, 
in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan Ltd.

1623-14, Shimotsuruma, Yamato-shi
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Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other 
country where such provisions are inconsistent with local law: 
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS 
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS 
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express 
or implied warranties in certain transactions, therefore, this statement may not 
apply to you. 

This information could include technical inaccuracies or typographical errors. 
Changes are periodically made to the information herein; these changes will be 
incorporated in new editions of the publication. IBM may make improvements and/
or changes in the product(s) and/or the program(s) described in this publication at 
any time without notice. 

Any references in this information to non-IBM Web sites are provided for 
convenience only and do not in any manner serve as an endorsement of those 
Web sites. The materials at those Web sites are not part of the materials for this 
IBM product and use of those Web sites is at your own risk. 

IBM may use or distribute any of the information you supply in any way it believes 
appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of 
enabling: (i) the exchange of information between independently created 
programs and other programs (including this one) and (ii) the mutual use of the 
information which has been exchanged, should contact:

IBM Corporation

J46A/G4

555 Bailey Avenue

San Jose, CA__95141-1003

U.S.A. 

Such information may be available, subject to appropriate terms and conditions, 
including in some cases, payment of a fee. 

The licensed program described in this document and all licensed material 
available for it are provided by IBM under terms of the IBM Customer Agreement, 
IBM International Program License Agreement or any equivalent agreement 
between us. 

Any performance data contained herein was determined in a controlled 
environment. Therefore, the results obtained in other operating environments may 
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vary significantly. Some measurements may have been made on development-
level systems and there is no guarantee that these measurements will be the 
same on generally available systems. Furthermore, some measurements may 
have been estimated through extrapolation. Actual results may vary. Users of this 
document should verify the applicable data for their specific environment. 

Information concerning non-IBM products was obtained from the suppliers of 
those products, their published announcements or other publicly available 
sources. IBM has not tested those products and cannot confirm the accuracy of 
performance, compatibility or any other claims related to non-IBM products. 
Questions on the capabilities of non-IBM products should be addressed to the 
suppliers of those products. 

All statements regarding IBM's future direction or intent are subject to change or 
withdrawal without notice, and represent goals and objectives only. 

This information is for planning purposes only. The information herein is subject to 
change before the products described become available. This information 
contains examples of data and reports used in daily business operations. To 
illustrate them as completely as possible, the examples include the names of 
individuals, companies, brands, and products. All of these names are ficticious 
and any similarity to the names and addresses used by an actual business 
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which 
illustrate programming techniques on various operating platforms. You may copy, 
modify, and distribute these sample programs in any form without payment to 
IBM, for the purposes of developing, using, marketing or distributing application 
programs conforming to the application programming interface for the operating 
platform for which the sample programs are written. These examples have not 
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or 
imply reliability, serviceability, or function of these programs. The sample 
programs are provided "AS IS", without warranty of any kind. IBM shall not be 
liable for any damages arising out of your use of the sample programs. 

Each copy or any portion of these sample programs or any derivative work, must 
include a copyright notice as follows:

© IBM 2011. Portions of this code are derived from IBM Corp. Sample Programs. 

© Copyright IBM Corp. 2011.

If you are viewing this information softcopy, the photographs and color illustrations 
may not appear.

Trademarks IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of 
International Business Machines Corp., registered in many jurisdictions 



N - 4
worldwide. Other product and service names might be trademarks of IBM or other 
companies. A current list of IBM trademarks is available on the Web at “Copyright 
and trademark information” at www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered 
trademarks or trademarks of Adobe Systems Incorporated in the United States, 
and/or other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and 
Telecommunications Agency which is now part of the Office of Government 
Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo, 
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or 
registered trademarks of Intel Corporation or its subsidiaries in the United States 
and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other 
countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of 
Microsoft Corporation in the United States, other countries, or both.

ITIL is a registered trademark, and a registered community trademark of the 
Office of Government Commerce, and is registered in the U.S. Patent and 
Trademark Office.

UNIX is a registered trademark of The Open Group in the United States and other 
countries.

Java and all Java-based trademarks and logos are trademarks or registered 
trademarks of Oracle and/or its affiliates.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in 
the United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are 
trademarks of HP, IBM Corp. and Quantum in the U.S. and other countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise, Gentran®, 
Gentran:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®, 
Gentran:Realtime®, Gentran:Server®, Gentran:Viewpoint®, Sterling 
Commerce™, Sterling Information Broker®, and Sterling Integrator® are 
trademarks or registered trademarks of Sterling Commerce, Inc., an IBM 
Company.

Other company, product, and service names may be trademarks or service marks 
of others.

http://www.ibm.com/legal/us/en/copytrade.shtml
http://www.ibm.com/legal/us/en/copytrade.shtml
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Glossary
Adobe Reader An Adobe program designed to read and display Portable Document Format 
(PDF) documents. Older versions were called Acrobat Reader.

application The business software generating the business information that you are sending 
or receiving electronically.

check in The act of returning a copy of a file from your working directory to the master 
directory, making it available to other users.

check out The act of copying a file from the master directory to your working directory, 
making the file unavailable to other users.

default A value that is automatically assigned.

DNS Domain Name Services.

EDI Electronic Data Interchange.

Application-to-application transfer of key business transaction information in a 
standard or XML format via a computer-to-computer communication link.

EDI standard A format to regulate syntax, structure, and content of transaction data.

GENCOD The GENCOD standard was developed by the French National Numbering 
Organization GENCOD-EAN France. The GENCOD standard is used mainly in 
France within the retail market by some major retailers and manufacturers.
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HIPAA Health Insurance Portability and Accounting Act.

lock The act of making a file unavailable to other users. A file is locked once it is 
checked out.

map A file that contains the relationships between:

◗ The segments and elements of a standard EDI document and the data fields 
in your application,

◗ The elements in an XML document and the data fields in your application, EDI 
standard document, or in another XML document,

◗ The segments and elements of two different standards, or
◗ The records and fields of two different applications.

master directory The directory on a PC or on a server that stores your master files.

master file The version of a file that Sterling Gentran:Server uses to process data. 

MDAC Microsoft Data Access Components.

NCPDP National Council of Prescription Drug Programs.

PCM Process Control Manager.

standard format A format intelligible to computerized data management systems.

temporary file A file on the client that Sterling Gentran:Server uses during editing and compiling.
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trading partner The company, division, or group with which you are exchanging business data 
electronically.

Trading
Partnership

An arrangement to exchange information in a specific document type with a 
specific trading partner and using a particular standard version.

unlock The act of making a file available to other users. A file is unlocked once it is 
checked in.

user directory The directory on the server that temporarily holds the files being transferred from 
a client working directory to the master directory on the server.

VAN Value Added Network.

VDA Verband der Deutschen Automobilindustrie. A German group responsible for a 
range of different standards in the automobile industry.

working file
directory

The directory created on the client to hold the files that a user is editing.

XML Extensible Markup Language. Describes a class of data objects called XML 
documents, and partially describes the behavior or computer programs which 
process them.
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